
The Complete Guide to Music Technology using Cubase 10
Sample Chapter

This is a sample of part of a chapter from 'The Complete Guide to Music Technol-
ogy', ISBN 978-0-244-72589-1, available from lulu.com.

It's published by musictechtuition.com, and for more information on the book, 
please go to :

http://musictechtuition.com/books/complete-guide-music-technology/the-com-
plete-guide-to-music-technology-using-cubase-10/

The content shown here is under half of the first chapter of the book, taking the 
user through basic sequencing and recording, but it covers many more techniques 
in over 600 pages:

• Sequencing - from basics to complex editing
• Samplers - Including Sampler Tracks
• Synthesizers - theory and programming
• Microphones - types, characteristics and placement
• Music Theory - understanding why music works
• Arrangements - how to arrange a piece in a new style
• Audio Editing - detailed editing techniques
• Effects - effects types and applications
• Mixing - techniques and practice
• The Mix Console - mixing effectively with Cubase
• Automation - making your mixes more interesting
• Chords - chord tracks, editing and chord pads
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Cubase 10 is music producti on soft ware - oft en called a Digital Audio Workstati on 
(DAW) - and one of its features is that it is a sequencer.  This means it can record 
notes that you play on a keyboard, and then play them back through a synthe-
sizer, allowing you to create compositi ons and hear what they sound like without 
using other musicians.  Very complex pieces of music can be built up doing this as 
you can create one track at a ti me and re-record it unti l you are totally happy with 
it, all at your own pace.  You don’t need to be a good keyboard player to get good 
results, either (although having some keyboard skills is a big help).  It’s important 
to remember that it deals with MIDI (which will be covered fully later on), and 
that really means notes being played, usually on a keyboard, so you can change 
the sound of what you’ve recorded aft erwards, but there are some limitati ons to 
how it will sound.

Getti  ng Started
Firstly you will need to start your computer and any other items in your setup.  
The order of this will change depending on your specifi c equipment, but there is 
a good rule of thumb here:
Tip: The speakers should be the last thing you turn on, and the fi rst thing that you 
turn off  – this is to avoid any ‘thumps’ damaging them (or your ears) when you 
turn the equipment on.  Usually the computer will be one of the fi rst things to be 
turned on and the last to turn off . Once this is done, you can start Cubase. 
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 Once it loads (which can take some ti me as it’s a large 
program), you will see a screen like the one on the left , 
it is the Steinberg Hub and it is there to allow you to 
pick from a number of templates, as well as tell Cubase 
where you want your project to be saved.

Tip: Whenever you use Cubase, it’s important to make sure your fi les are where 
they should be – in some situati ons the computer is used by a number of people, 
and in additi on it’s really important to save each project in a separate folder – this 
means you will easily be able to back your work up later on.
To create a new folder for your project, click in the area next to Project Folder at 
the bott om right of the Steinberg Hub window, and type the name of the folder 
you want to create, and then in the upper secti on click More and then pick Empty.  
Now click the Create butt on at the bott om and Cubase will make the folder and 
a new project. 
Tip: Remember that USB fl ash drives and external hard drives are becoming in-
creasingly aff ordable, and their cost is small compared to the amount of ti me 
that you would need to recreate any work if it was lost.  Backing up your work is 
a necessity, as is regularly saving your work.  Computers crash, parti cularly when 
running complex soft ware such as sequencers, and hard drives fail.  If you save 
regularly and back up oft en then you will not lose a great deal if the worst hap-
pens.
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Here we see the main Cubase window, 
with the Transport Bar at the bott om.  The 
transport bar is like the remote control 
for a video recorder, although it has more 
functi ons, the basic controls are the same, 
as we’ll see later on. The central area is 
the project window.  This is where all your 
tracks will be created and the majority of 
your work will be.

The fi rst thing to do is to create a new track.  Go to Project > Add Track > In-
strument, and a new window will appear where you can select an Instrument.
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Click where the window says No VST Instrument and a list will appear of the in-
struments your computer has available.  Pick Prologue from the Synth folder (as it 
is available on all Cubase 10 systems), and click Add Track.  You should now see a 
screen similar to the one shown below.
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Here is the Cubase window, with Prologue 
located in the centre of the screen.  While 
you will be editi ng the controls later on, 
at the moment we don’t need to see Pro-
logue, so close the window to reveal...
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... the project window with Prologue track 
in it.  On the left  of the screen is the In-
spector, showing details such as track 
name, inputs and setti  ngs.  If the inspec-
tor isn’t present...

... click this butt on to make it visible.  It can 
also be enabled with CTRL + ALT + L.

The Inspector is very important as it allows you to alter the volume and panning 
of a track (more of this later), and most importantly pick the sounds you wish to 
use.  We will see how this works in a while, but fi rstly we will look at a few things 
we need before we get started.
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 The  Transport
The transport (hit F2 if you can’t see it) allows us to control Cubase, making it play, 
stop, record, rewind and a host of other features.  We won’t cover them all here, 
but we will cover the basic controls that you need to get you sequencing.

The transport controls. The highlighted butt on is STOP, 
and to the right are PLAY and RECORD.  The butt on on 
the left  turns CYCLE on and off , allowing us to repeat a 
parti cular secti on - see page 12.
Tempo control, metronome and count-in.  Here the 
tempo can be set (once the tempo track is turned off  
by clicking the butt on at the left ), and the click can be 
turned on and off  with the butt on to the left  of the e.

Time readout.  This can be in a number of formats, 
but bars and beats (at left ) is probably the best setti  ng.

Locators.  As we’ll see later on, the locators allow us to 
cycle round a secti on, to practi ce it or record several 
ti mes.  They can be set by double-clicking the num-
bers and typing a new value.
Input/Output acti vity.  This shows MIDI in and out 
(left  two meters) and audio input and outputs (stereo).

The Transport Bar in Cubase 10 is highly confi gurable - and would take several 
pages to describe all the available opti ons - but suffi  ce to say that you can turn 
secti ons on and off  using the cog at the right hand side, and alter the appearance 
of each secti on by clicking the three dot menu to the right of each secti on.

Here we see the eff ect of this on the transport 
controls secti on.  The fi rst view is the default 
with just four controls present.  The next mode 
adds butt ons to move between markers, and the 
third mode adds fast forward and rewind con-
trols.

The  Metronome
It is very important that when you play music into Cubase that it is in ti me with 
the metronome.  Computers may work extremely quickly, but they do not have 
much intelligence, and as a result they need to be told things that we may take 
for granted.  One of them is the tempo of a piece of music – Cubase can’t really 
work that out, so to make life easy in the long run, you should play in ti me with 
the metronome.  This is easily achieved, fi rstly by turning it on using the butt on 
above - it will turn white. Pressing Play on the transport bar should now mean 
you hear an indicati on of the tempo of the piece. 
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Changing  Tempo
If you want to change the speed, make sure that the tempo track is turned off  
click the butt on above on the transport bar so that it is dark grey, and then enter 
the tempo that you want by double-clicking it and typing the speed you want.  
You may need to experiment to fi nd the right speed, and remember that you can 
always change the speed of what you’ve recorded aft er you’ve done it.  This has 
an important benefi t if you’re fi nding a part diffi  cult - you can record diffi  cult parts 
slowly to make them easier to play, then return the tempo to normal aft erwards.
 Picking a sound
Many synthesizers provide a wide range of sounds (referred to as patches) and 
these should cover most eventualiti es – there are usually over a hundred on a 
basic synth, and on some there can be thousands.  However, picking them can be 
a litt le diffi  cult as there are so many to choose from, but the Inspector makes it 
easier.

Here is the inspector, with the Prologue in the 
track.  The black area at the bott om (above No 
Drum Map) is where the patch name will appear 
when one is selected, so click there... 
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... and the patch list appears.  Here you can list all 
the sounds that the synth has, and there are many 
(334, as shown at the top right).  If you want to 
explore, feel free to do so, you can scroll through 
the list and click once on a sound and you will be 
able to hear it played using your MIDI keyboard 
– you may fi nd a sound that inspires you or takes 
your compositi ons in new directi ons. 
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There are so many sounds that it’s hard to fi nd 
the right one quickly.  If you click where it says 
Search Results and enter a word (or part of one) 
then it will only show you sounds that are rele-
vant to that – both in their names and also their 
categories/descripti on, so if you enter bass (as 
seen here) then you should get bass sounds, even 
if their name doesn’t make that obvious.  Not all 
instruments have descripti ons in their patches, 
however.
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Naming Tracks and Parts
It’s important to name each track – at first it’s easy to know what’s what as you 
may only have one or two tracks.  When your piece develops, you may end up 
with many tracks, and knowing instantly what each one is will help.  To name 
it, double click where the track says Prologue 01 and name it appropriately – 
melody, bass, chords or whatever you want to call it. 

The Info Line
If you have the Info Line present (if it isn’t, click the icon above right and select 
it from the menu that appears), then you can name the parts you create as well, 
avoiding confusion if you have musically different parts.  It can also be of benefit 
to use the colour palette  to colour parts, providing an instant visual clue when a 
part is different from its neighbours.

Toolbar and Transport Setup
There is a great deal of information that can be present on screen in Cubase, and 
both the toolbar and transport bar area have too many options to fit on most 
screens.  As a result, you will need to be familiar with getting the tools you need 
on screen.  This is done using the cog icon which allows the setup of the toolbar 
or transport to be altered.  If a tool, icon or menu is mentioned in this book and 
you can’t see it, then click the cog and turn that section on.  You may need to 
turn other sections off to see the desired section in full - particularly in the case 
of the transport bar (where some sections can be expanded in size, as seen on 
page 5).

Making a recording
Cubase will record whatever you play on the keyboard.  To do this, select a track 
(if you only have one it will already be selected, this is shown by it being lighter 
than the others), and look to see that the red ‘record enable’ button is lit up on 
the track itself – it should be as soon as you select the track, but it’s possible for 
it to be turned off.  This button doesn’t mean that the track is recording straight 
away, but it means that when you press record it will record on this track.  Next, 
we need to tell Cubase to give us a count-in (normally this is 2 bars).  This is done 
by activating the Count-in button, near the metronome button– it looks like this: 

Now make sure Cubase is at the start of the song, and hit Record.  Cubase will give 
you a 2 bar count-in, and then start recording.  Play something on the keyboard, 
and you should see it appear as you’re recording.  Once you’re happy, press Stop.  
Go back to the beginning of the piece (pressing , on the keyboard next to M will 
do this, although a good way to remember it is to think of the < pointing back to 
the start of the project) and press play to hear what you recorded.
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If you’re not happy with the recording, then often the best thing to do is to delete 
it and start again – unless there is some unique part of it that you think you could 
never reproduce, the best thing to do is to start again, as this will improve your 
keyboard skills quite quickly if they need to be improved, and mean that in the 
future you can sequence things with much more speed and accuracy.  
Tip: To delete a part, select it (left-click it) and then hit Backspace on the com-
puter keyboard.  
To record again, just repeat the steps above.
Snap
Snap is extremely important.  Without it, it would be very difficult to make parts 
in the project window which were exactly the right length, whether it’s bars or 
beats we are after. What snap does is makes sure that any movements you make 
and any edits you do are constrained to a grid, which minimizes the room for 
errors. Whenever you’re making any changes in the project window, make sure 
that snap is turned on, and initially make sure that it’s set to Bar.  The settings for 
Snap are found at the top of the project window, and the correct ones are shown 
below:

The button at the left turns snap on or off.  Next to it is an area that shows the 
current setting (which is set to Grid).  The size of the grid is set by the next two 
boxes - the first is currently set to Bar (which we want).  Ignore the 1/16 section 
for the time being – this only applies if the middle menu is set to Use Quantize, 
which you will need later on.
Later on, as your sequencing develops, you will find times when you don’t want to 
use snap, or you want it set to different values.  But initially it’s best to stick with 
it set to a grid of bars, as this leaves the least room for problems!
Trimming a part to size
When creating a song, it’s often made up of smaller ‘building blocks’ – these could 
be a verse, chorus or other section of a song that you wish to repeat.  When you 
originally record them, they might end up being too long, for instance if you didn’t 
hit stop right on the end of a bar, you may well end up with a bar of silence.  This 
can be easily trimmed away – just hover your mouse over the part in question, 
and it will have small  ‘handles’ at the bottom corners – one for the start and one 
for the end.

Here we see the part, with a bar of 
silence at the end.  At the bottom cor-
ners there are ‘handles’ which you 
can click and drag to size the part.
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If the part has been selected, it will 
look like this - dark with the ‘handles’ 
being lighter.

In either case, you can click and drag 
the end one to the left...
... to produce a part of the correct 
length.  Note that if you do this to 
an area which has notes in it, they 
will not be played, but they are not 
lost – you can extend the part again 
using this technique and they will re-
appear.

Make sure snap is turned on when doing this, or the timing of your part will suffer.
Adding another track
To add another track, you can do so in the way you did before – go to Project > 
Add Track > Instrument.  It is important to experiment with the different Instru-
ments you have on your system, which can create a wide range of sounds.
Adding Drums
Drums are an important part of many styles of music, so adding them is often 
needed.  To do this, create an instrument track as shown above, but this time 
you will pick Groove Agent SE from the Instrument menu.  Now, using the patch 
selector (as shown on page 6) pick the Dry Standard Kit (remember you can 
search for it with the keyword ‘drum’). This means that instead of playing notes, 
the keyboard will play drum sounds – on most keyboards/synths you will find that 
the C note to the left of the keyboard will be a bass drum, with snare above it 
on D and E, toms above that, while the hi-hats will be on F#, G# and A#.  Learning 
what sounds are where will take some time (experiment to find which sounds are 
where), but the basic parts of the drum kit are found on the left-hand end of the 
keyboard.  There is a map of some of the keyboard in the MIDI Chapter on page 
51.  As before, recording drums is just like recording any other MIDI, although 
the playing may be more complex if you’re trying to play a full kit’s worth at once.
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Adding more notes to a part
If you have problems playing all of a drum track at once, then there are a num-
ber of ways to do it.  The first way is to record ‘on top’ of the first part you have 
recorded.  Simply go back to the beginning of the track, and then record again on 
the same track – the notes you’ve already played will be played back to you, and 
you’ll create a new part on top of the original one; Cubase will show the part with 
diagonal lines on it to show you that there is more than one part in that location, 
and once you’re happy with the second part you have made, you can select the 
‘glue’ from the toolbar at the top and glue the top part to the bottom – you’ll now 
see a part with both sets of notes in (see diagrams below).  Once you’re finished 
working with the glue, you can return to the arrow tool, either by using the tool-
bar, or right-clicking on the white area of the project window and selecting it from 
the pop-up menu.

Here we see the initial part that has been record-
ed.  Cubase is set to record from the start on the 
same track, and we see below.....

... that the notes get recorded and seem to be in 
the same part, but the part has a diagonal pattern 
on it - this shows that there is another part be-
low this one.  Both still play, even though they are 
on top of each other.  If we want them to be one 
part, we select the glue from the toolbar above, 
and click on the part, leading to...

.... a final part which has the notes of both parts.

Picking which tracks play
Cubase has two important buttons which will let you hear the tracks you want, 
and stop others from playing.

Mute
Mute will stop any track that has it turned on from playing.  Click on the button so 
that it is selected in yellow, and play your track back - the track will not be heard.  
You can do this for as many tracks as you want.  To un-mute them, either click the 
mute button on the track, or you can clear all mutes with the clear mutes button 
which is in the toolbar at the top of the window.  

If you want to mute a track you have selected (i.e. it is in white in the list) then 
press M on the keyboard.
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Solo
Solo will mute all tracks other than the one(s) you have soloed (press S).  This 
makes it quick and easy to hear a track you want to hear in isolation.  You can solo 
multiple tracks if you want, and each one is toggled by clicking the solo button 
on the track in question. CTRL clicking a Solo button will mute any other already 
soloed tracks.  As with mute, there is a clear all solo button in the toolbar at the 
top of the window.

Creating an arrangement
Usually, a song will consist of several parts, some of which will be repeated.  This 
can be done quickly and simply in Cubase.  Firstly, create the parts that you want 
to use for the song – you can do this on several tracks, using different instru-
ments, but for clarity the diagrams below will only show one track.
The first thing to realise is that you can move any part to a new location by clicking 
and dragging it there.  When you do so, make sure you have snap turned on, as 
then your part will be in time.  You can also drag a part to a new track to make it 
play on a different sound – sometimes this happens accidentally.  
However, often copies of the original parts are needed, to make the piece larger – 
repeating sections of an entire song, or copying a bar from one place to another.  
There are a few ways to do this, as seen below.

Here we see the original part, 4 bars from bar 1 to 
bar 5.   For each step below, the first part has to be 
selected.

Edit > Functions > Duplicate.  A single copy is 
made, directly after the original part.

Edit > Functions > Repeat.  A new dialogue box 
appears, asking for the number of copies – here 3 was 
entered. Useful for creating many copies. 
Holding down ALT while dragging the part to a new 
location will create a copy – this is useful when a copy 
doesn’t need to be directly after the original.

Using these simple techniques allows a song’s structure to be built up quickly and 
easily.
Practicing a section
When a part is simple to play, then it can often be done with little practice.  But 
sometimes it’s necessary to repeat a section so you can practice or work out what 
you want to play.  Here’s where the locators come in.  Cubase has two main loca-
tors, left and right.  They can be used to create a cycle which Cubase will repeat 
until you tell it otherwise.  To do this, firstly we need to set the left and right loca-
tors.  This can be done in a number of ways:
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1 – Double-click the area on the transport bar where the current value of the 
locator is, and enter a new value.  For bar 5, just hit 5 and Enter on the keyboard.
2 – You can CTRL-click on the ruler (showing the bars across the top of the pro-
ject window’s white area) to set the left locator, and ALT-click to set the right 
locator.  This needs accurate mouse placement, though.
3 – If you have a part or parts that you want to cycle round, select them and then 
hit P on the keyboard.
All of these will set the locators, and once you have done this, you can activate 
Cycle on the transport bar (the button to the left of stop – it will turn blue when 
it’s on), and Cubase will cycle round the contents between the two locators.  You 
can now practice the section that you wish to record or create until you get it 
right.
Cycle Recording
While cycling to play a section and practice it is useful, it is also useful sometimes 
to record while in cycle mode.  This gives a number of different options, including 
recording several different versions of the same part, or to add notes to the part 
as you go.  We will look at three of the available options.
Adding notes to a part
A common need is to add notes to a part.  While we have seen this being used 
when recording without Cycle mode, in cycle mode it is possible too.  The first 
thing is to ensure that the MIDI Record Mode is set to Mix, by clicking the button 
below:

Clicking here will summon the MIDI Record Modes menu:

Now, with the locators set, a part can be played.  Each time round the cycle, the 
notes you play will be added to the previous notes - they will not overwrite them.  
This is a quick way of building up a drum part, as seen here.  The first time round 
the cycle, the bass and snare drums were played:
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The next time round the hi-hats were added:

You can cycle round as many times as you like, and whenever you add a note it 
will become part of the recording.
Keeping only the last version
If you want to keep only the last version you record, this is easily done.  Set the 
MIDI Record Mode to Keep Last:

Now proceed as in the previous section; when you stop, only the last version you 
did will be left.  This can be useful when you are trying to get a part right, and will 
stop as soon as you have done that.  Often if you keep starting and stopping to 
record, it can stop you from getting in the feel of things, so having Cubase cycle 
round until you get it correct can save time. 
Recording different versions
Sometimes, you may want to keep recording while you play different versions of 
that section, and then decide later which version you want to keep.  To do this, set 
the MIDI Record Mode to Stacked, from the right-hand side of the pop-up menu 
on the Transport Bar.

As you record with cycle turned on, you will see each part recorded, and it may 
look as if the other versions have been lost (much as in the previous section) - 
here is the result after four cycles.  

Note that the part says Take 4 - this was on the fourth repeat.  If we play the track 
back, we get the fourth version that was played.  However, the others are still 
present.  
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Clicking the Show Lanes button will reveal the previous 3 Laps.

At present, Lap 4 is the version that is heard.  If you want to hear another one, 
you can use the Comp tool - see page 26 - or you can use the Mute tool to mute 
one of the lanes, and then again to allow another one to play (see page 24 for 
the Mute tool).   The Comp tool is explained on page 446 in the Audio Editing 
chapter, but works for MIDI as well as audio, so the instructions there will show 
you how to use it for more than merely choosing which lane to play.  Note that 
with either method, if you change the lane which is active, the note display on the 
track changes to reflect the part that will be played - here Lap 2 has been chosen, 
and the track part reflects this both in name and note content.

If you want to return the track back to being viewed normally (without lanes), 
then click the Show Lanes button again.
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Editi ng
One of the most powerful reasons to use a computer for creati ng music is that 
you can alter what you’ve played aft er the event – you can change the sound that 
something is played back on, and you can also alter the notes that you’ve played.  
Simple editi ng will save you hours of work – while it is always a good idea to try 
to improve your keyboard skills and play something in real ti me, there will always 
be ti mes when you will need to edit what you have played.  To open the editor, 
double-click a part you have recorded.  This will open the ‘key editor’, which is like 
the paper roll from a player piano.

Here we see the key editor, with ti me running 
from left  to right, and the notes going up the 
left -hand side of the screen, from low to high.  
The notes of the part are represented as rec-
tangles, and the colours show how hard the 
note was hit (called Velocity in MIDI terminol-
ogy), from blue to red (soft  to hard).

The fi rst editi ng is quite simple.  As we’ve seen in the project window, each note 
can be moved to a new locati on, and again it is controlled using snap – this will 
make the notes ‘sti ck’ to a grid, and we can set the size of the grid. 

Listen to the part you’ve created, and work out the grid that it should fi t to – if it 
has only one note per beat (quarter notes/crotchets), then set the snap to ¼.  If it 
has two even notes per beat (eighth notes/quavers) then set it to 1/8, etc.  Once 
you have done this, you can move the notes to the ‘correct’ locati on by clicking 
and dragging them – note that the positi on that you click on the note is crucial – if 
you click at the beginning or end you drag the note out.  If they are all fairly close 
and you have set the snap setti  ng correctly, then hit Q on the computer keyboard 
for ‘quanti ze’ – this will move each note to the nearest ‘correct’ grid positi on; this 
may or may not work well depending fi rstly on if you’ve chosen the correct snap 
setti  ng, and secondly if you’ve played it accurately!  It’s not unusual to have to 
correct some notes by hand, but quanti zing can save a lot of manual work.  There 
is more informati on on this on page 70.
If there are any notes that you don’t want, you can select them and hit Delete.   
You can also edit the velocity of the notes that you have played (i.e. how hard you 
played them – for most synths this translates into the volume of the notes being 
played). This is done in the “controller lane” at the bott om of the window, as seen 
on the next page:



16

Sequencing - Sample Chapter

sa
m

ple
 do

wn
loa

de
d f

ro
m

ww
w.

m
us

ict
ec

ht
uit

ion
.co

m

If there is no controller lane, click on the plus at the bott om of the editor area and 
one will appear.  
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If the controller lane is not displaying velocity, click on the triangle that appears 
on the current controller name to bring up the pop-up menu, and pick Velocity 
from it.
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You can pick a variety of parameters to edit with the pop-up menu on the left  
of the lane, but Velocity is what we’re aft er at the moment. You should see col-
oured bars which represent the velociti es of each note that you have played – by 
default, they will be short and blue for lightly-played notes, tall and red for notes 
that were played loudly, and in-between for others.  You can see that in this exam-
ple, they are all the same velocity (100 in this case, from a range of 1-127).

To edit the velociti es, you can move the selecti on tool over the velocity area - note 
that it turns into a pencil when you move there.  You can now click and drag the 
note velociti es to the desired levels, and you should hear the eff ect of doing so.
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You can also use the line tool in a variety of modes (see page 25), which will 
allow you to alter the velocities in a number of different ways.

Once you’re finished in the editor, hit Enter and you’ll be back to the project 
window.
Non-Keyboard player tips
If you are not already a competent keyboard player then you may find sequencing 
quite frustrating or difficult – particularly if you are trying to sequence something 
that already exists.  There are a number of things you can do to help your situa-
tion:
Keyboard Skills – improving these will pay the largest dividends.  If you can learn 
basic keyboard technique it will enable you to translate your ideas into parts a lot 
more quickly.  Knowing where the notes are on the keyboard is important, as is 
being able to play simple chords.  If you can gain some independence between 
your two hands then this will make matters even better, particularly when you 
start to program drum parts in real time.
Slowing things down
Often a complex part will be difficult to play at the correct speed, and one way 
round this is to slow Cubase down, and then play the part at a lower (achievable) 
speed – see page 6 – and you can then put Cubase back to the original speed.
Recording rhythm then changing the pitch
This is a useful skill when you know what you want to play but can’t do it quickly 
enough (or it’s too complex to get).  Firstly, pick a note that fits OK with whatever 
backing you have, and then record the correct rhythm of the piece, but all played 
at the same pitch – this should be doable for just about everyone.  On the next 
page we see the rhythm of our melody has been recorded, all on a single note.
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The next step is to correct the pitches of the notes that you’ve played in.  You can 
do this by editi ng each one, but it can be laborious.  If you know what notes you 
need to play (which is oft en the case with a melody which you know or that’s 
writt en down) then open the part you have just recorded in the key editor.  Select 
the fi rst note of the melody, and then click the MIDI Input butt on at the top.   This 
enables input from the MIDI keyboard.  You will see there are three butt ons with 
notes on to the right of this.  Make sure the ones with the arrows are turned off  - 
this will mean only the pitch of the note is being altered as you press keys on your 
keyboard.  The correct setti  ng is shown below.

You can now play the correct pitches in, one at a ti me, and Cubase will alter the 
pitch of the current note, and move to the next one.  In this way anyone who can’t 
read music quickly can input a rhythmically accurate version and then change the 
pitches quickly - below is the part with half the notes replaced.

Below is the completed melody.  Don’t forget to turn MIDI Input off  aft er complet-
ing the task, as otherwise you may accidentally alter a part without realising. 

 Step Input
There is another way to record MIDI data in Cubase, and instead of being in real-
ti me (like the recordings we have already seen), it is done in what is called ‘step 
ti me’.  This means that there is no clock or ti ming running, instead Cubase will 
move forward in ti me each ti me you play a note, and you can wait as long as you 
like between them.  This removes the need to play notes in quick succession, 
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which can oft en be useful for those fi rst using the keyboard, or when sequencing 
parts which are too diffi  cult to play at a reasonable speed.  It also opens up some 
more creati ve possibiliti es as well.
To use Step Input, fi rstly create a new, empty part.  This can be done in a number 
of ways, either selecti ng the pencil tool in the project window and clicking and 
dragging to draw the part:

Or if you have your locators set you can double-click between them on the ap-
propriate track.  

Once you have your part, double-click it to open it in the editor.  You will now 
need to turn Step Input on, using the icon located towards the top of the editor. 
(you may need to enable Step/MIDI input by clicking the cog in the top right of 
the editor window)

Next, set the step size.  This is done by altering the quanti ze value at the top of the 
editor, seen here set to 1/8.

Finally, you will need to set the step input locati on - where you want the fi rst note 
you play to appear.  Usually it will be at the beginning of bar 1. You can change 
it by pressing the left  and right cursor keys on your keyboard - you should see a 
blue line showing where it is (it becomes yellow when it coincides with Cubase’s 
play positi on line).  You can also set it by clicking in the main secti on of the editor 
window (where the notes appear).
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Here is the empty part, with the step input line on 
the left  - it is in yellow as the play positi on line is 
there too, so diffi  cult to see.  However, Cubase is 
ready to take the next note or chord played, and 
when you do so and release it...

...two things happen:  Firstly, the note or chord 
that you played has been created in perfect ti me - 
it starts precisely where the input locati on was set, 
and it is exactly the length you set.  Secondly, the 
blue step input line will have moved on to the next 
grid division, ready...
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... for the next one.  Once it is played and released, 
the same thing happens again - the ‘perfect’ chord/
note is created with the right start and end points, 
and the step input line moves another division for-
ward.  

Note that it’s possible to change the quanti ze value 
without leaving step mode - the next chord/note 
you play will be input with the value you have set 
(here it was changed from 1/8 to 1/4).

Note that when you are using Step Input, once you press a key on the MIDI key-
board, you can press more keys to make a chord, and it is only when you release 
them all that the input is actually taken, so you don’t have to hit all the notes at 
the same ti me.  As with MIDI note input above, ensure you turn Step Input off  
when you have fi nished, or you can enter notes without realising it!

Saving your work
This is the most important thing you can do!  Make sure that you save your work 
regularly.  It is an unfortunate fact of life that computers crash someti mes.  Cu-
base is a very complex piece of soft ware – we’ve just scratched the surface of it 
here – and someti mes it crashes.  Whenever you’ve done something that you like, 
save your work! It’s quickly done by pressing CTRL+S, and it can save you hours of 
ti me if something goes wrong.  You can also set Cubase to auto-save by going to 
Edit > Preferences > General and ti cking  Auto Save – it’s really easy to forget 
to save work in the middle of a sequencing session, so this is a good idea.  If you 
need to back your work up, then see page 43 for how to do this.

The  toolbar
At the top of the project window and editors in Cubase you will see the toolbar.
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This allows you to select diff erent tools, making the mouse cursor perform diff er-
ent tasks.  We will now look at the tools that are available to you, and some of 
their uses. 

The Selecti on Tool (Press 1)
This is the default mode - the arrow that you have already been using - where you 
can click and drag a part to a new locati on, and use the sizing handles that appear 
to alter the length of parts.  This is the mode you will use more than any other, 
and it can be accessed by pressing 1 on the main keyboard.  If you click and hold 
on the tool on the toolbar, a pop-up menu appears:
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This allows the selection of different modes for the tool, which alter what hap-
pens when you re-size an event.  Note that pressing 1 repeatedly will cycle through 
these modes.
Normal Sizing
As we have already seen, it is possible to click and drag a start or end handle, and 
change the length of a part.  This is the default mode.

Sizing moves contents
In this mode when you re-size a part, the contents will move when you do so.  
Here is an example to show that in action.



22

Sequencing - Sample Chapter

sa
m

ple
 do

wn
loa

de
d f

ro
m

ww
w.

m
us

ict
ec

ht
uit

ion
.co

m

Sizing applies Time Stretch
In this mode, when you re-size a part, the contents will be stretched or squeezed 
according to the change in length that you apply.  Here is an example to show that 
in action.

The Range Selection Tool (Press 2)
The Range Selection Tool lets you click and drag to select an area across a number 
of tracks, and then move the contents of the area you have outlined to a new 
location by clicking and dragging.  It can be useful for making large changes to a 
sequence without having to spend a long time separating all the parts that you 
want by using the scissors (see the next section for the scissor tool).  Here we see 
a sequence which has had an area selected by clicking and dragging.

Once the area has been selected, hover the mouse over it - it will turn into a hand 
and now the area can be moved by clicking and dragging.



This represents just a small fraction of the first chapter of the book - 
around 20 pages from a total of over 600.

If you have found this information useful, please consider 
purchasing the book from lulu.com.

Thanks

Darren Jones
(author)


